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Version History 

Version Date Revision Summary 

1.0 11/17/2023 We’ve added or revised the following for v5.11.0: 

• Added a section on Procedure Notes, covering the new 
option to Reply directly to notes and assign to other 
users. See section 3.4.4 for details. 

• Added steps to send multiple procedures for review at 
once (Bulk Review). See Section 3.5.2.2 for bulk review 
steps. 

• Updated the Approving Procedures section (3.5.3) to 
note that the Send for Further Review action can now 
be taken multiple times, with no limit to the number of 
reviews. Previously this could only be done once. 

• Added note to the Attaching Documents section (3.6.1) 

noting the 190-character limit for attachment names. 

• Updated the Adding Findings section (3.8.1) to note the 
new Finding URL included in each Finding, along with 
the Copy Finding URL button. 

2.0 5/24/2024 Versioned for v5.14.0; no functional changes. 

3.0 7/16/2024 Versioned for v5.15.0; no functional changes. 
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1 Audit Management Overview 

This section provides an overview of the Audit Management application. 

1.1 About Audit Management 

The Audit Management application allows executives to track, assign, and prioritize programs, 
program areas, and activities for audit engagements in the upcoming fiscal year. The system 
allows Audit Directors and executives to assign engagements based upon the skillset of 

specific auditors within their organization. After assigning resources to engagements, the 
system allows the users to create an engagement plan and generate the plan document.  

Once the executives have approved a written plan, the system allows Audit Teams to conduct 
their engagements and track work papers associated with the different steps in the audit 
engagement. After completing the engagement, the system allows the users to generate the 
draft final report and exchange the document until executive level approval has been granted. 

1.2 Home Screen 

The eCASE Audit Management Home Screen is shown below, with annotations on notable 

features: 

 

1. Click the Application Title to return to the home screen from any page in the application. 

2. Use the Quick Search bar to perform quick searches on Documents, Projects, Project 
Templates, or Audit Plans using a word search or an attribute search.  
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3. Select an application through the Application Selector icon, view your User Profile, and 
explore Help links. 

4. Use the Launch Pad to create a new Audit Plan, execute Searches, view the Inbox, and 
open Reports.  

5. The Dashboard displays open case folders and workflow tasks assigned to a user. 

 

This home screen serves as a jump-off point for using the eCASE Audit Management features. 
For additional information about the general eCASE interface, please refer to the eCASE User 
Guide, accessible under Help in the upper-right of the eCASE Dashboard. 

1.3 How Audit Management Works 

The Audit Management system is primarily composed of four major components:  

• Plan 

• Projects/Audits 

• Findings 

• Recommendations  

 

All of the actions users can take in the Audit Management application are driven by a Fiscal 
Year Plan. The Fiscal Year Plan encompasses executive priority of programs, program offices 
and activities for deeper assessment of a possible engagement. The Fiscal Year Plan addresses 
Project Plans at a higher level. It is composed of Programs, which are consolidated groups of 
Projects with a common goal or initiative. A Project is the smallest component of the solution, 
and it is granular and focused in its objectives. The graphic below illustrates the top-down 
relationship between Plans, Programs, and Projects in the Audit system. 
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Put simply, a Fiscal Year Plan is composed of several programs supporting the overall goals of 
the fiscal year. These programs are made up of any number of supporting audits, called 
Projects. Using the Audit application, users can create a fiscal year plan, devise objective-
driven programs to support that plan, and structure auditing projects to support these 
program objectives. 

1.4 System Roles 

The preconfigured system roles within eCASE Audit Management are described in the 
following table: 

Role Description 

Project 
Administrator 

A system level role, provisioned to the primary administrator 
users of the system who can read and write access to the project 

tab and view all current projects. 

Project Owner The Project Owner has the same privileges as the Project 
Administrator, but only for the projects for which they are 
assigned.  
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Role Description 

Preparer This is a staff role, a user who can create and process projects 
within a Fiscal Year Plan. 

Reviewer This is a staff role, a user who reviews the work submitted or 
created by Preparer users. In some instances, Reviewers may 
also have the ability to edit work submitted and created by 

Preparer users.  

Read Only This is a staff role, a user who only has read access to case 
folders and cannot edit or submit information.  

Sensitive This is a staff role, a user who has special access permissions to 
any attachments which are marked as sensitive.  

Preparer/Reviewer This is a staff role, a user who has the permissions of both a 

Preparer user and a Reviewer user. A Preparer/Reviewer user 
cannot submit work to themselves to review.  
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2 Fiscal Year Planning 

The subsections below describe how to create a Fiscal Year Plan and the Work Topics used to 
drive the Fiscal Year Plan. 

2.1 Create/Access Fiscal Year Plan 

Within the Launch Pad, you can create or view a Fiscal Year Plan by selecting either the New 
or View options, respectively, under the Main Menu. 

      

2.1.1 View a Fiscal Year Plan 

To view an existing Fiscal Year Plan: 

1. Within the Launch Pad, click Main Menu > View > Fiscal Year Plan. The application 
executes a search for all existing Fiscal Year Plans and displays the results in a table view. 

2. Select the desired Fiscal Year Plan and click Open. The Fiscal Year Plan case folder opens, 
displaying the Fiscal Year Plan tab.  

 
(!!) Notes: 

• Only one Fiscal Year Plan can exist per calendar year.  
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• All work topics that have not been completed in prior fiscal years are listed as carry-
overs in the Launch Pad.  

2.1.2 Create a Fiscal Year Plan 

To create a new Fiscal Year Plan: 

1. Within the Launch Pad, click Main Menu > New > Fiscal Year Plan. The New Fiscal Year 
Plan window appears.  

2. Select the year for the plan from the Audit Plan Fiscal Year drop-down list.  

(!!) Note: Only one Fiscal Year Plan can exist per calendar year, per Audit Team. If you select 

a Fiscal Year that already contains a plan, the page refreshes to indicate that “The Fiscal Year 
Plan already exists.” You can create multiple Fiscal Year Plans for multip le Audit Team. The 
Audit Team drop-down list is NOT a required field. 

 

3. Select the Audit Team from the drop-down list. 

4. Click Next. The New Fiscal Year Plan window appears. 

 

5. Complete the required fields and click Save to create the new Fiscal Year Plan.  

2.1.3 Add a Work Topic to the Fiscal Year Plan 

To add a new work topic to the fiscal year plan: 

1. Within the Fiscal Year tab, enter the Name of the work topic in the Work Topic field.  
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2. Select the category from the Category drop-down list.  

3. Click Add to Plan. The page refreshes and displays an expanded Fiscal Year Plan tab. 

 

2.2 Interacting with Work Topics 

Certain fields can be used within the elements of a work topic to drive priority. Work topic 

elements include: 

• Profile 

• Risk 

• Objectives 

• Projects 

 

At any time within these element screens, users can navigate back to the Launch Pad by 

clicking Back to Launch Pad. 

 

2.2.1 Work Topic Profile 

To manage the work topic profile: 

1. Navigate to the desired Work Topic and ensure the work topic has been added to the 
fiscal year.  

2. Within the Fiscal Year Plan tab, click Profile  in the Profile column in the desired work 
topic to create and edit the profile. The tab refreshes to display the Profile workspace. 

 

3. Enter a Description of the Work Topic in the Description field.  
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4. Enter any Initial Objectives in the field, if applicable. 

5. Enter the Provision of Law in the field, if applicable. 

6. Enter the Scope in the field, if applicable. 

7. Enter the Work Topic Justification in the field, if applicable. 

8. Select the Management Challenge from the drop-down list, if applicable. 

9. Select the Strategic Challenges from the drop-down list, if applicable. 

10. Select the Signification Impact from the drop-down list, if applicable. 

11. Select the High Risk from the drop-down list, if applicable. 

12. After making any changes, click Save and Go to Risk to proceed to the next section. 

13. Alternatively, click Save to save the current section and postpone proceeding to the next 
session.  
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2.2.2 Manage Work Topic Contacts 

The work topic Profile page also allows users to track the contacts associated with agency 
programs relating to the work topic. To track contacts: 

1. Open the work topic and navigate to the Contacts section of the Profile page. Click Insert. 

 

2. After clicking Insert, the workspace refreshes to display a blank Project Contact lookup 
field. Click the Contacts lookup.  

 

3. The Search for Contact window appears. Enter the contact search criteria in the applicable 
fields and click Search.  

4. Alternatively, click Search to return search results listing all application contacts.  
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5. The window refreshes to display a set of search results matching the selected criteria. 
Click the desired user and click Select.  

 

6. The search window closes. The selected contact appears in the Project Contact field.  

(!!) Note: Multiple contacts can be selected for a Fiscal Year Plan. 

7. To view full contact details, click the contact lookup icon to open Contact View in a new 
tab. 

 

8. Click Save and Go to Risk. Alternatively, click Save to only save the update. 

 

2.2.3 Work Topic Risks 

To manage risk associated with a work topic: 

1. Navigate to the desired Work Topic and click the Risk icon  in the Risk column of the 
Launch Pad.  
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2. The workspace refreshes to display the Risk screen. The Risk workspace displays the risk 
factors which are auto populated based on the system level metrics. In this screen, you 
can determine the likelihood and impact of each factor by choosing the corresponding 
number of check marks, with a range of 1-5.  

 

3. Additionally, users can add custom risk factors into the work topic by clicking Insert 
below the last risk factor row. After clicking Insert, the page refreshes to display a new 
blank row at the base of the table. Enter a name for the new Risk factor in the blank field 
within the Project Risk Factor column.  

 

4. Choose the likelihood and impact of the custom factor by clicking the desired checkbox 
(X/5) for each column. 

5. Add Comments in the field. 

6. Complete the Weight % field. 

(!!) Note: Risk weights are calculated as percentages, so the sum of all risk weights must 
equal 100. 

7. When finished, click Save. 

8. To return to the Launch Pad, click Back to Launch Pad. 

2.2.4 Work Topic Objectives 

To manage the objectives, scope, and justification of a work topic: 

1. Navigate to the desired Work Topic and click Objectives  in the Objectives column of 
the Launch Pad.  

2. The Objectives screen appears. Enter the Objectives in the field.  
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3. Enter the Objective Scope in the field. 

4. Enter the Objective Justification in the field. 

 

5. When finished, click Save. 

6. To return to the Launch Pad, click Back to Launch Pad. 

2.2.5 Add a Project 

The final work topic element is to create projects. Users can add multiple projects to work 
topics. To add a project: 

1. Navigate to the desired Work Topic and click Project  in the Objectives column of the 
Launch Pad.  

 

2. Fill out the Project Title and Project Description. 

3. Use the drop-down lists to select a Project Type, Management Challenge, Region, and 
Service Code. 
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4. Select the Custom Audit Template from the drop-down list. See Section 4.1 - Create New 
Templates for more details. 

5. Click Add Project. The workspace refreshes and the new Project Entry appears in the 
Project Summary list. 

 

(!!) Note: Users are not able to modify the audit template used in the project after it is 
created. The audit project folder is built based on the template name chosen at this stage.  

6. Click the Edit icon in the Summary Column to open the corresponding Project Case 
Folder in a new tab.  

(!!) Notes: 

• There can be more than one project associated with a work topic. Additionally, there 
can be multiple work topics within a Fiscal Year Plan.  

• Click the Edit button in the left column to open the project.  
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3 Audit Management 

The subsections below describe the actions, requirements, and responsibilities typical to a 
conventional audit and how they intersect with the eCASE Audit Management Solution. 

3.1 Project Set Up 

After a Project is created within a Fiscal Year Plan, it must be populated with content to 
progress through the workflow to completion. To set up a Project:  

1. Open the Fiscal Year Plan and click Project  for the desired work topic.  

2. The page refreshes to display the Project workspace in the Fiscal Year tab. Click Edit  
to launch the project.  

 

3. The Project Set Up window appears in a new tab, containing additional required fields 
which were not populated during the fiscal year planning phase. Complete these new 
required fields.  

4. Within the Project form, there are two sections: Initiation and Project Information. The 
Initiation section includes the information provided upon the project creation from the 
Fiscal Year Plan Launch Pad. The Audit Information section includes various fields that 
provide details and useful information pertaining to the project.  
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5. Complete the required fields. 

(!!) Notes:  

• Required fields are indicated with a red border or red exclamation mark. 

• The fields Project: Region and Project: Assisting Region cannot contain the same value.  

• Users and User Groups who are authorized to edit the Project tab are determined 
during configuration.  

6. Click Save. 

(!!) Notes: 

• As the remaining Project required fields are completed, the status of the project 
automatically updates. The status progresses from “New” to “Conduct of Field Work” 
after an authorized user completes any remaining required fields and saves the updated 
case folder. 

• Based on the configured required fields, if all fields are completed upon initial creation 
of a project, then the project skips the “New” phase and automatically moves into 
“Conduct Field Work.” 

3.1.1 Alternative Project Set Up/Creation 

1. Typically, new Projects are created directly within the Fiscal Year Plan case folder, 
however, users can also use the Launch Pad to create new Projects. 

2. Click Main Menu > New > Project. 

 

3. The New Project form appears. Use the drop-down list to select the Fiscal Year to which 
the Project corresponds. The workspace refreshes and the Existing Fiscal Year Work Topics 
lookup field appears.  
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(!!) Note: The Fiscal Year chosen must contain a pre-existing plan/work topic. If not, the user 
is prompted to create a plan with at least one work topic in order to add the project through 
this method. 

4. Click the Existing Fiscal Year Work Topics lookup. The Select Item pop-up window 
appears.  

5. Select the desired Work Topic radio button and click OK.  

 

6. The pop-up window closes, and the selected work topic appears in the Existing Fiscal Year 
Work Topics field. Click Next.  
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7. The workspace refreshes, and the Project Set Up form appears, which includes the 
Initiation and Audit Information sections described in the Project Set Up section. Complete 
all required fields (indicated by a red border). 

 

8. Click Save. 

 

9. The workspace refreshes and displays the newly created Project case folder, with the 
Project tab displayed. 



Audit Management 

 25 

 

3.2 Project Milestone Dates 

Each Project has its own set of associated Milestone Dates. These dates are specific to the 
Project and are recorded on the Project Milestone Dates tab. It is important to note that just 
like the main Project form/tab, only users with the Project Administrator or Project Owner role 
are allowed to edit/update this set of dates. 

3.2.1 Adding Milestone Dates 

1. The Project Administrator or Project Owner must open a project and click the Milestone 
Dates tab. 

2. Click Add. 

 

3. The workspace refreshes and displays the Add Date Workspace. Enter the Date Name in 
the field.  

 

4. Click Save. The workspace refreshes to display the full Milestone Dates workspace, 
including the newly added Milestone Date. 
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(!!) Note: Any existing Milestone Dates from the Project Template that was used for the 
project are automatically imported and displayed in the Dates table. 

3.2.2 Importing Milestone Dates 

In addition to manually adding milestone dates, there is an option to import the Milestone 
Dates from another Project Templates. To import milestone dates: 

1. The Project Administrator or Project Owner must open a project and click the Milestone 
Dates tab. 

2. Click Import Milestone Dates. 

 

3. The page refreshes and displays the Search for existing Milestone Dates page. Enter any 
relevant search filters in the Choose Template and/or Name of the Date fields. 

 

4. Click Search. The workspace refreshes and displays a set of search results which match 
the search criteria.  

5. Click the checkboxes adjacent the Date Names to import. 
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6. After selecting the desired milestone dates to import, scroll to the end of the search 
results and click Add Milestone Dates. 

 

7. The workspace refreshes and a confirmation message appears. Click Yes. 

8. The page refreshes to display the imported Milestone Dates. 

 

3.2.3 Using the Milestone Dates Workspace 

There are three date fields available for each Milestone: Planned, Revised, and Actual. These 

fields are used to calculate and populate the Next Milestone and Days to Next Milestone fields 
in the Milestone Dates and Project tabs. Use the date picker to select each date in the 
workspace. 

• Planned: This is the initial planned date. When a date is selected in this field, it is used 
with the current date to calculate the Next Milestone and Days to Next Milestone fields.  

• Revised: If a date is revised after the initial Planned Date, select this date within the 
Revised date column. When a date is entered in the Revised field, it is then used to 
calculate the Next Milestone and Days to Next Milestone fields. 

• Actual: Record the project milestone date of completion in the Actual field. When a date 
is selected in this field, the system counts this topic as complete, and the next Milestone 
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with a provided Planned or Revised date is used to populate the Next Milestone and Days 
to Next Milestone fields. 

(!!) Note: Click Save after completing or altering any Milestone date field. 

After the dates are provided and the form is saved, the Next Milestone and Days to Next 
Milestone fields are calculated using today’s date as seen in the example image below. In the 
example below, ‘Date Name 1’ was completed, which is shown by an Actual date selected in 
the table. The Next Milestone and Days to Next Milestone fields are then calculated using 
‘Project milestone 2’ (Documentation Date Name) and its Revised date, as it is the next 
milestone with dates provided. 

 

3.3 Adding Staff 

After completing and entering all required information on the Project and Project Milestone 
Dates tabs, the next step is adding the Staff working on the Project. By default, the user that 
created the project appears in the Staff tab as a Preparer. There must be at least one Preparer 
and one Reviewer on each project to be able to progress through to the rest of the case 
folder functions/workflow. 

1. Navigate to the Staff tab of the desired Project case folder.  

 

2. Click Add User.  
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3. The Select User pop-up window appears. Select the user role from the Role drop-down 
list.  

(!!) Note: Additional Roles may appear in this pop-up window if your application 

administrator has created roles in addition to the COTS Roles. 

4. After making a role selection, the User lookup field appears. Select the username from the 
directory by clicking the lookup tool.  

 

5. The pop-up window refreshes to display a list of contacts who can be assigned the role. 
Select the checkbox adjacent the desired user and click OK.  

 

6. The workspace refreshes, and the selected user appears in the User field. Click Add.  
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7. The Staff tab refreshes and the selected user is now shown in the User/Group list. Repeat 
these steps for all staff members for the project. 

3.4 Planning – Building an Audit Program 

The audit program populates information based on the template chosen during work topic 
configuration. The audit program displays a list of procedure groups and procedures that have 
already been created within project templates. Users can create additional procedures and 
procedure groups in the project beyond what is provided in the template. 

(!!) Note: There is an 8,000 character limit for each procedure you create.  

3.4.1 Create New Procedure Group 

To create a new procedure group: 

1. Open the desired Project case folder and navigate to the Procedure tab.  

 

2. Click New Procedure Group. The group letter field automatically populates based on any 
previously existing procedure groups.  

 

3. The page refreshes to display the New Procedure Group workspace. Enter the Group 
Name in the field.  

 
4. Click Save. 

5. A confirmation window appears. Click OK. The pop-up window closes, and the Procedure 
workspace displays the newly added Procedure Group.  
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3.4.2 Create New Procedure 

To create a new procedure: 

1. Open the desired Project case folder and navigate to the Procedure tab. 

2. Click New Procedure within the desired procedure group.  

 

3. The workspace refreshes to display the New Procedure workspace. Enter the Procedure 
Name into the Procedure Name field. 

 

4. Click Save. 
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5. The workspace refreshes to display the full Procedure tab, with the newly added 
procedure within the selected Group.  

 

(!!) Note: New procedures enter the program in Created status, as indicated by the white 
circle. Procedures shift from Created to Prepared status only after they are sent for review. 

 

3.4.3 Preparing Proposed Procedures for Approval 

New procedures enter the program in Created status, indicated by a white circle within the 
procedure entry. Created procedures are typically modified before being sent for review and 
entering the Prepared status; however, it is not necessary to do so if all the required 
information was added to the Procedure during creation. When users make any changes to a 
procedure, specifically to the procedure elements Purpose, Scope, Source, Results, and/or 

Conclusions, the status changes to Modified, which is indicated by a yellow circle. 

 

To complete each of the procedure elements: 

1. Click (+) to expand the procedure group. The page refreshes to display additional 
information, and the Green (+) button becomes a Red (–) button.  

(!!) Note: You can click the – button to collapse the procedure group. 

 

2. Click View to make changes to the procedure.  
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3. The Edit Procedure workspace appears and includes the following features:  

a. Sequence: Captures information on this procedure’s place in the sequence and 
includes an Attachment button. 

b. Procedure Lead: Select a user to act as the lead user for this procedure. 

c. Procedure URL: Copy this URL to link other users directly to this procedure within 
eCASE Audit.  

d. Procedure Sections: Edit the procedure’s Purpose, Scope, Source, Results, and 
Conclusions. 

 

4. Use the Lookup tool to select a Procedure Lead, the user who is responsible for this 
procedure: 

 

5. The Select Item pop-up window appears. Click the radio button adjacent the desired user 
and then click OK.  

6. Update the Procedure sections (Purpose, Scope, Source, Results, Conclusions), by clicking 
the corresponding Lock Procedure Section button. The workspace refreshes to display 
the locked procedure section, an Unlock button, and the Procedure section button. 
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7. Click the desired Procedure Section button to open the element editor. 

 

8. A text editor window appears, allowing users to add or edit the details of the procedure 
element. 

 

9. After sufficient information has been added or updated, click Save. 
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10. Provide additional information for all remaining procedure elements (Purpose, Scope, 
Source, etc.). 

(!!) Note: Users are unable to alter these Procedure elements after submitting procedures for 
review. 

11. Each procedure element’s History is tracked individually, allowing users to view edits 
made by any other user (using Single View), as well as view side-by-side (using Side by Side 
View) as shown in the example below: 
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(!!) Note: An elements History is accessible from the text editor window of the procedure 
element. Once the text editor is open, for example Purpose, the History button is located in 
the bottom left corner of the editor window, highlighted below. 

 

12. After the desired fields are completed, click Update in the Edit procedure form.  
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(!!) Note: After completing the required procedure elements, users can also attach 
documentation to the procedure. 

13. A confirmation window appears. Click Close. The page refreshes, a pop-up window 
appears, and the changes to the procedure tab are recorded. 

 

3.4.4 Procedure Notes 

You can add notes to each procedure, including the ability to mark notes as resolved and 

reply directly to notes. Click the Notes button next to any procedure to open the Notes 
window: 

 

After clicking Notes, the workspace refreshes to display the Notes editor. 

(!!) Note: The Procedure status must be Created, Modified, Reviewed, or Post Edit Review 
status before Notes can be added to the case folder. 
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Notes can be added to a procedure element under the Add Notes section. Enter the relevant 
information in the Comments field, select an Assignee from the drop-down list, and click Add 
to add the note.  

Notes that have been reviewed can be marked as resolved by clicking the (A) Resolve button. 
Alternatively, you can Unresolve a note to revert the review status. There are also options to 
(B) Bulk Resolve or Bulk Unresolve to resolve or unresolve more than one note. 

 

After adding notes, the Notes button appears in red under the procedure elements list 
indicating there is an unresolved note. After resolving notes (by clicking the Resolved button), 
the Notes button appears in green. If no notes are present, it appears in gray: 
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You can also reply directly to notes to add a commentary trail. To add a reply, click Reply: 

Additional fields appear where you can add Comments, then select an Assignee to assign the 
note directly to another user. Click Post to post your reply. 

3.5 Completing Field Work 

Although eCASE Audit Management does not formally transition a user from the Planning 

phase into the Field Work phase, the system does allow users to effectively move into this 
phase once all procedures have been completed or modified. 

3.5.1 Procedure Statuses 

During the lifecycle of submission to acceptance, procedures may progress through the 
following statuses: 

Status Description 

Created The status of any procedure which has been recently added or 
imported. 

Modified The procedure has been edited. 

Prepared The procedure has been sent for review 
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Status Description 

Rejected The procedure has been rejected during review. 

Escalated The procedure has been sent for further review. 

Reviewed The procedure has been approved. 

Post Edit Review Any edits or modifications after the procedure have been reviewed. 

Request for 
Deletion 

At least one procedure has been reviewed within the procedure 
group, but now has a request for deletion pending 
approval/rejection. 

 

3.5.2 Sending Procedures for Review 

Procedures can be sent for review individually or in bulk. 

3.5.2.1 Send Single Procedure for Review 

To send a single procedure for review: 

1. Open a Project case folder and navigate to the Procedure tab. 

2. Click Review in the Procedure to send for review.  

 

3. The tab refreshes to display the Procedure Summary workspace. Any previously completed 
Reviews are visible in the History subsection. Select the Assignee from the Assigned To 
drop-down list.  
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4. Enter any additional information in the Comments field. 

5. Click Submit for Review. The procedure is submitted to the assigned user for review.  

 

6. The workspace refreshes to display the full Procedure tab, which shows the submitted 
procedure in Green status indicating that it is Prepared.  

 



Audit Management 

 42 

3.5.2.2 Send Procedures for Bulk Review 

You have the option to send multiple procedure for review at once. To send procedures in 
bulk: 

1. Open the Project case folder and navigate to the Procedure tab, then click Bulk Review:  

 

2. The Bulk Review of Procedures screen appears. First, select who the procedures will be 
Assigned To: 

 

3. Next select the Due Date and add any Comments. 

4. Under Choose Procedures, use the checkboxes to select the (A) Procedures you’d like to 
send for review. You can also click the (B) top checkbox to select all procedures: 
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5. When you’ve selected the procedures for review, click Submit for Review. 

3.5.3 Approving Procedures 

Only users with Reviewer privileges can approve procedures. Procedures sent for review are 
listed in the Reviewer’s inbox, in the Project section. As a reviewer, users can access projects 
by clicking the Assignment Number in the inbox. To approve a procedure: 

1. Assigned Procedure Approvals appear in the Projects widget in the inbox. Open the 
project by clicking the Assignment Number. 

 

2. The workspace refreshes and the assigned Project case folder appears. Navigate to the 
Approvals tab. Any procedures with approval requests are displayed within the Procedure 
Approvals section.  
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3. You can utilize the following features to manage, approve, or reject the procedure: 

Feature Description 

History View the Action History of the procedure/procedure group. 

Cancel (Workflow) Cancel the request if the procedure was submitted in error of if 
you want to cancel the procedure preparation without logging 
the disapproval. 

View/Cancel View the procedure details page. 

Comments Enter additional information regarding the approval. 

Approve Move the procedure into Reviewed status, indicated by a blue 
circle. This can only be performed by the assigned reviewer. 
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Feature Description 

Reject End the approval workflow and indicate that the procedure 
was rejected in Action History, indicated by a black circle. This 
procedure must be in the Modified status base on the rejection 
reason to resubmit for review. 

Send for Further Review Select another user to conduct an additional review. This action 

can be taken multiple times as needed but must be completed 
by the assigned user. When sent for further review, the status 
of the procedure will change to Escalated, which is indicated by 
an upward arrow. 

 

Authorized users can also perform Bulk Approvals/Rejections, if desired.  

 

1. To perform a Bulk Approval, select the procedures to Bulk Approve. Then, click Bulk 
Approve in the Procedure Approvals header. This will move all selected procedures into 
Reviewed status. This can only be completed by an assigned reviewer. 

2. To perform a Bulk Rejection, select the procedures to Bulk Reject. Then, click Bulk Reject 
in the Procedure Approvals header. This will move all selected procedures into a Rejected 
status. This can only be completed by an assigned reviewer. 
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3. After selecting Approve/Reject/Send for Further Review, a confirmation window 
appears. Click Yes to perform the selected action. 

 

4. The workspace refreshes, and the selected procedure approvals are now locked. 

3.5.4 Post-Edit Review  

Any updates made to a procedure after it has been reviewed will change the status of the 
procedure. Approved procedures enter Post Edit Review status, which is indicated by a red 
circle. Post Edit Review procedures must reenter the Review/Approval process before you can 
close the Project.  

The Post Edit Review process follows the same steps detailed in the previous sections. The 
procedure reenters Reviewed status after it is reviewed/approved again. 

3.5.5 Request for Deletion 

If necessary, procedures can also be deleted. Only users with sufficient permissions can 
request a procedure deletion. After a procedure enters Reviewed (Blue dot) status, it must 
undergo a request for deletion approval before it is formally deleted. To delete a procedure, 
follow the steps below: 

1. Open the desired Project folder and navigate to the Procedure tab. Click View in the 
desired procedure entry. 
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(!!) Note: The procedure must be in Reviewed (blue dot) status before you can request 
deletion. A procedure in Created or Modified status can be directly deleted by authorized 
users. 

 

2. The page refreshes to display the Edit Procedure workspace. Click Request For Deletion in 
the Edit Procedure form. 

(!!) Note: If the procedure is locked, the Update, Review, and Request For Deletion buttons 
are inactive. To click these buttons, first unlock the procedure by clicking Unlock.  

 

3. The Request for Deletion workspace appears. Select the Assignee from the Assigned To 
drop-down list.  



Audit Management 

 48 

 

4. Select the due date using the date picker. 

5. Enter any Comments in the field. 

6. Click Submit. 

7. The status of the procedure changes to Deletion Requested and is indicated by a green 
square. The request appears in the Approvals tab under Procedure Approvals. The approval 
workflow follows the same steps as a procedure review. 

3.6 Work-Paper/Document Management 

eCASE Audit Management provides extensive document management capabilities. In addition 
to adding any document to a case folder as an attachment, eCASE Audit Management allows 
for online editing of Word, Excel, PowerPoint, and PDF documents. The application also 

allows users to view those documents in an Online environment. 

3.6.1 Attaching Documents 

Documents can be added directly to procedures by within the View procedure page. 
Attachments can also be added in the Attachments tab and filed under a procedure. The steps 
to add an attachment are the same for either scenario.  

(!!) Note: There is a 190-character limit for attachment names. For ease of use, ensure that 
attachment names are shorter than 190 characters before adding. 

To add a document via the Attachments tab: 

1. Open the desired project folder and navigate to the Attachments tab. 
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2. Select My Computer from the Add From drop-down list.  

 

3. The Attachment Properties screen appears. To designate the desired attachment, click 
Select. 



Audit Management 

 50 

 

4. The File Explorer window appears. Select the desired attachment.  

5. Click Open. The file explorer window closes and the selected attachment appears in the 
File(s) to be Attached field. The Attachment Name field auto-populates once the 
attachment is uploaded.  

 

(!!) Note: If the attachment is being uploaded within a feature, the following steps are 
completed automatically. 
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6. Select the Attachment Types from the drop-down list.  

(!!) Notes:  

• The Attachment Type selection corresponds to the highest level in the attachments tab 
folder structure. Depending upon your configuration, this field may already be 
populated. 

• If adding from the Attachments tab, select Project. This attachment type allows a user 
to file this under a procedure, as this option will further populate the Procedure Groups 
and Procedure drop-down lists. The following steps assume Project has been selected.  

7. Click the Sensitive checkbox, if applicable. This checkbox is visible only to users who have 
been assigned to the project in the Sensitive role.  

(!!) Note: Users must be granted the Sensitive role in the Staff tab to mark an attachment as 
Sensitive. 

8. Select the Procedure Groups from the drop-down list.  

9. Select the Procedures from the drop-down list, if applicable. 

10. Select the Actions from the drop-down list, if applicable. 

(!!) Note: The Reviewed By, Reviewed Date, and Reviewer’s Comment fields are locked and 
are completed at a later stage in the workflow. 

11. Click Add. The pop-up window closes, and the tab refreshes to display the attachment in 
the selected section of the folder structure. Additionally, attachments can be added to the 
Attachments tab via the drag and drop feature. 
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(!!) Note: If the attachment is a child document, click the checkbox next to the parent 
document and repeat the steps above using the Add Child From drop-down list, instead of 
the Add From drop-down list. 

 

12. From the local machines file system/explorer, drag the desired attachment(s) into the 
eCASE Attachments tab workspace.  
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13. Complete steps 5 through 10 in the procedure above. After dropping the attachment into 
the Attachments tab workspace, the Add New Attachment pop up window appears.  

(!!) Note: You cannot add child attachments using the drag and drop feature. The parent 
attachment must be selected before a child attachment can be added underneath.  

3.6.2 Uploading Documentation Using Letter Templates 

Authorized users can upload attachments to a case folder via preconfigured Letter Templates. 
To upload attachments via letter template: 

1. Navigate to the Attachments tab of the desired case folder. 

2. Select Letter Template from the Add From drop-down lit. 

 

3. The Letter Template Information window appears. Select the desired Letter Template from 
the drop-down list and click Select. 

 

4. The select window closes and the Add New Attachment window appears, containing the 
letter template in the File to be Attached field. Select the Attachment Type from the drop-
down list. 
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5. Complete the remaining fields within the pop-up window. Click Add. 

6. The pop-up window closes, the Attachment tab refreshes, and the letter template 
attachment appears in the selected folder of the document structure.  

(!!) Note: Letter Templates are configured by individual organizations, so required fields and 
functionality will vary. 

3.6.3 Completing Work in Documents 

There are two primary methods to complete work within eCASE attachments: Online Editing 
Mode and the Native File Format. Follow the procedures below to complete work using the 
desired method. 

3.6.3.1 Online Editing Mode 

Word, PowerPoint, Excel, and PDF documents can be edited using the eCASE Online editing 
capability. To perform work in an attachment using Online Edit Mode: 



Audit Management 

 55 

1. Click the checkbox adjacent the attachment to edit online. 

2. Select Online from the Edit drop-down list.  

 

3. The attachment appears in a new tab. Highlight the desired text and right click. Select 
Add Comment from the drop-down list. 

 

4. Users can reply to comments by clicking Add Reply.  
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(!!) Note: A list of all document comments can be viewed by clicking .  

 

(!!) Notes:  

• Comments can be marked as resolved by clicking the checkbox in the first comment of a 
thread.  

• Any changes made in the document are automatically saved. 

 

5. You can also directly edit the attachment within the text editor. Click Save after making 
any changes. 
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3.6.3.2 Native File Format 

Users can complete work in attachments in their native file formats-while using eCASE Audit 
Management as a tracking tool. To perform work in the native file format: 

1. Click the checkbox next to the desired document. Select Check Out from the Edit drop-
down list.  

 

2. The Check Out window appears. Enter information about the work to be done during 
check out and click Check Out. The attachment is downloaded to your local computer for 
work.  
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3. Open the document. The document launches in its native program. Perform any required 
edits. 

4. After editing, save the attachment and click the checkbox next to the attachment in the 
Attachments tab. Click the Edit drop-down list and click Check In.  

 

5. The Check In pop-up window appears. Click Choose File and select the updated 
document. 

6. Enter any relevant information about the work performed in the Comments field.  
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7. Click Check In. 

(!!) Notes:  

• After check in, the document’s version history is automatically updated. To view this, 
select the desired document, click the Manage drop-down list, and select Version 
History. 

• Users can also create new documents within eCASE. Without a document selected, 
navigate to the Add From drop-down list and select the New (Attachment Type) menu 
option.  

 

3.6.4 Hyperlinking and Bookmarks 

(!!) Note: Procedure sections must be in Created (white circle) or Modified (yellow circle) 
status to edit the procedure and add hyperlinking or bookmarks. 
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3.6.4.1 Hyperlinking in Word Documentation 

Point-to-point hyperlinking or referencing can be performed in documents through either 
Online Edit mode or via Word document bookmarks. To hyperlink within online mode: 

1. Open the desired document in Online Editing mode and click the References tab within 
the document ribbon. 

2. Highlight the text to use as the reference and then select Bookmark. 

 

3. The Bookmarks pop-up window appears. Enter a Bookmark Name in the field. 

(!!) Note: Do not enter spaces in the Bookmark Name field.  

 

4. Click Add. The bookmark is added to the document. Click Save to record your changes. 

5. Navigate back to the Attachments tab. Click the checkbox adjacent the attachment 
containing the added bookmark. Click the Send To drop-down list and select Create ref 
link.  

(!!) Note: After adding the bookmark, it may take up to one minute for the bookmark to be 
available in eCASE. If the bookmark is not available after opening the copied reference link, 
refresh the page and try again. 
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6. Select the bookmark by name from the drop-down list and click Copy.  

7. Additionally, you can select Document to link the entire document. 

8. Alternatively, within the same Send To menu, the user can select Copy to Clipboard to 
copy the Document URL. 

 

9. The bookmark/document is now copied to the clipboard and can be added in either 
another attachment, or in another text box. The subsections below explore each option.  

3.6.4.2 Hyperlinking in PDF Documentation 

To create a hyperlink to PDF Documentation: 

1. Open the desired case folder and navigate to the Attachments tab. Select the desired PDF 
Attachment.  

 

2. Select Online from the Edit drop-down list. 
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3. The selected attachment appears in a new tab, in .PDF format. Click the Comments tab 
and select the Hyperlink option.  

4. Using the hyperlink tool, create a square around the text to hyperlink.  

5. The Actions pop-up window appears. Select Open web link from the Select Actions drop-
down. The Enter a web URL Link field appears.  

6. Paste the previously copied URL link in the field and click OK.  

 

3.6.4.3 Bookmarking in PDF Documentation 

1. Open the desired PDF Attachment. 

2. Click the cursor option within the menu bar and highlight the desired text by clicking and 
dragging the cursor over the text.  
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3. The Highlighting menu appears. Click the bookmark icon. 

 

4. A pop-up window appears. Enter a Bookmark name in the field. 

 

(!!) Note: PDF Bookmarks can’t include spaces. It is recommended to use underscores to 
separate words. The system prompts the user to remove any spaces in the text field after 
clicking OK.  

5. Click OK.  

6. The left-hand menu displays a list of bookmarks, including the one just added.  

7. Click OK to add the bookmark. Click the X button in the menu bar to save and close the 
Document.  

 

8. The Attachments tab appears. Select Create REF Link from the Send To drop-down list. 

9. A pop-up window appears displaying a URL. Click Copy to copy the URL to your 
clipboard. 

10. A confirmation window appears. Click OK.  
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11. Return to the desired PDF to hyperlink the desired PDF using the copied URL.  

(!!) Note: Wherever eCASE features hyperlinking capabilities, you can include the copied 

URL to bookmark to the desired PDF.  

3.6.4.4 Bookmarking in Another Attachment 

To use the bookmark in another attachment: 

1. Open another attachment in Collaborative Edit (Online) mode. Highlight the desired text 
that will host the bookmark. Right click and select Hyperlink. 

 

2. The Hyperlink Settings pop-up window appears. Paste the copied URL into the Link To text 
box. 

3. Enter any ScreenTip Text in the field, if desired. This is text that will appear if the cursor 
hovers over the bookmark.  

4. Click OK. The hyperlink is now active.  
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3.6.4.5 Bookmarking in Another Text Box 

To use this hyperlink in another text box, such as a procedure element or finding element: 

1. Navigate to the text box which requires the hyperlink. Highlight the desired text which 
will feature the hyperlink.  

 

2. Click Hyperlink  to generate the hyperlink. The Hyperlink Settings window appears. 

3. Paste the URL into the Link To field and click Insert. The window disappears and the 
hyperlink is now active.  

4. Users can check the Open in new tab option to force the link to automatically open in a 
new browser tab. 
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3.6.4.6 Procedure Element Highlighting and Bookmarks 

Users can create hyperlinks and bookmarks to individual procedure elements, if desired. To 
create procedure element hyperlinks or bookmarks: 

1. Open the desired Project folder, and click the Procedure tab.  

2. Click View within the procedure row.  

 

3. The Edit Procedure workspace appears. Copy the Procedure URL. 

 

4. Click the desired Procedure step (e.g., Purpose, Scope, Source, etc.) and, within the pop-
up window, select the text to function as a bookmark. 

5. Click Create Highlighted Link to create a bookmark.  
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6. The text is highlighted in Yellow, and a flag icon appears adjacent the text. Click the flag 
icon to expand the highlight drop-down list. Here you can select Copy Link, Delete Link, 
or Close.  

 

7. Select Copy Link to copy the bookmark link to the clipboard. The bookmark can now be 
added to any desired attachments or procedures and will function as an active hyperlink.  

(!!) Note: Wherever the hyperlink is clicked, eCASE opens the procedure element in a new 
tab.  

3.6.5 Procedure to Procedure Interactions 

Procedure to Procedure hyperlinking is completed using the Procedure URL located in the 
Edit Procedure window. 

Citations are intended to be used when users need to create a bridge between multiple 
documents or project fields. 

1. Navigate to the Procedure tab of the case folder. 

 

2. Click Expand All or the green plus sign  button on the desired Group to expand the 
menu. Then, click View adjacent the desired Procedure button. 
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3. The Edit Procedure window appears. Click the desired section of the procedure to open 
the Edit window. 

 

4. Enter the desired citation text into the text editor and click Insert Citations. 

 

(!!) Note: eCASE adds the citation link wherever the cursor is placed within the text editor.  

5. Click the Citation icon in the free text field to open the Add Citation Links pop-up window.  

6. Within this window, users can click Add to add a citation link, Delete to delete the entire 
citation link, or Close to close the window.  

 

7. Click Add. 
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8. The Add Links pop-up window appears. Within this tab, users can cite entire documents 
by selecting the checkbox adjacent the desired document.  

9. Click Expand (+) to display a list of all individual bookmarks within the document.  

 

10. Click the desired checkboxes, and then click Add Links. The window closes. The link is 
now active. 

11. Click the Add Citation Links icon to open the Add Citation Links window. The window 
displays all previously added bookmarks/documents.  
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(!!) Note: Citation Tags can only be opened within an edit window, and not directly from the 
case folder tab.  

3.6.6 Document Reviews 

Like procedures, documents can be routed for review and approval. Documents also have a 
Status and follow the same status progression as procedures. To send a document for review: 

1. Navigate to the Attachments tab of a project and click the arrow next to the file name to 
expand the secondary menu. 

2. Select Workflow. 

3. Click Assign Task.  

 

4. An email message pop-up window appears with the Basic tab displayed, as shown below. 
The Email Notifications tab allows you to configure Email Notifications, if desired. 
Complete the fields in the basic tab: 
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5. Select an assignee for this task by clicking the Select User lookup.  

6. Configure the Due Days Type and Due Days using the Due Days Type drop-down list and 
Due Days field.  

7. After the Basic details are complete, click the Email Notification tab, and configure the 
message content. 
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8. Configure the recipients for the notification using the To field. 

9. Click the Send a Calendar Appointment as Attachment checkbox to include a calendar 
appointment with the message. 

10. Edit the Subject field, if necessary. 

11. Edit the Message content, if necessary. 

12. After the task and notifications are configured, click Start to initiate the workflow task 
and send the email notification.  

13. The assigned reviewer must sign in to eCASE Audit Management, where they will see that 
they have been assigned a task. Assigned Tasks are displayed in the User Inbox. Navigate 
to the Approvals tab to act on the document review.  

(!!) Notes:  

• Document Approvals follow the same process as Procedure Approvals 

• Users can perform the same actions for Documents as Procedures with the addition of 
downloading  the document to their local disk. 
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3.7 Project Budgeting and Time 

eCASE Audit Management allows users to track and add time to a project. The system 
automatically calculates the cost incurred by a project based upon a user’s pay rate. This rate 
is set based on the OPM locality pay tables. To track time a user must be added on the Staff 

tab of a project. Once the user is added to the Staff tab, the user can track time against that 
project. 

3.7.1 Tracking Time 

To track time associated with direct and indirect charge codes: 

1. Login to eCASE Audit Management and click TimeXpress within the Launch Pad to launch 
the time tracking module. 

 

(!!) Note: Most users can only view the Employee menu. If a user also acts as an approver, 
they can access the Approver menu as well. 

2. Click Edit/View My Timesheet. 
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3. The Timesheet window appears. Use the arrows to select the desired timesheet. 

 

4. To add a new Task Row, click the blue (+) sign. A new row appears.  

 

5. Within the new row, click Select. The Select Task and SubTask pop-up window appears.  

6. Select the Task and the Sub Task from the drop-down lists. You can see the project 
numbers if you have been added as a staff member.  
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7. If applicable, select the Sub-Sub Task from the drop-down list.  

8. Within this drop-down list users can view the preconfigured project related activities, 
travel, and overtime selections. If you select one of the configured activities, this 
multiplies the hours by the normal OPM rate; overtime hours by overtime rate and travel 
costs are calculated as separate items.  

9. If necessary, click (+) to create a new line for a separate task.  

 

10. If the user selected a Project fiscal Sub-Sub Task or Overtime, they must add their hours 
into the Date columns corresponding to the hours worked.  

 

11. If the user selected a Travel Sub-Sub task, enter the travel amount into the Cost column. 

 

12. After finishing the timesheet, click Save. 

13. Once the timesheet is ready to be approved, click Submit. Both saving and submitting 
calculates and adds the time to the Project Cost tab.  
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3.7.2 Reviewing Timesheets 

Users with Approver privileges can review user submitted timesheets. To review user 
submitted timesheets: 

1. Login to eCASE Audit Management and click TimeXpress within the Launch Pad to launch 
the time tracking module. 

2. Click Approve/Deny Timesheets.  

 

3. The Employee Timesheets for Approval window appears, displaying a list of all pending 
timesheets.  

 

4. Click the checkbox next to the timesheet to review and click Approve/Deny. 

 

5. Review the timesheet content. Based upon the accuracy of the information within the 
timesheet, render an Approval or Denial in the timesheet by clicking the appropriate 
checkbox, and then clicking the Approve/Deny button. 
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6. The determination is rendered, and if denied, the timesheet is returned to the user for 
correction.  

3.8 Logging Findings and Recommendations 

Findings and Recommendations can be logged and linked to procedures (using the procedure 

URL) throughout the course of a project. 

3.8.1 Adding Findings 

To log findings for a project: 

1. Open the desired Project folder and click the Findings tab.  

 

2. Enter the finding information in the Finding text field.  

3. Click Add to add the Finding and continue tracking additional Finding elements. The page 
refreshes and the newly added Finding Information is added to the Finding tab.  
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4. Click Edit. The workspace refreshes. 

 

5. Complete any relevant additional elements, such as Condition, Criteria, Cause, Effect, and 
Impact.  

 

6. You’ll also note a Finding URL field with a URL that links directly to this finding. You can 
click Copy Finding URL to copy this URL to your clipboard. 
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7. Click Update to record the changes.  

 

3.8.2 Adding Recommendations 

Recommendations can also be added to each Finding. To log recommendations for a finding: 

1. Open the desired Project folder and click the Findings tab. 

 

2. Click Recommendations adjacent to the desired finding. 

 

3. The workspace refreshes to display the Finding Recommendations workspace. Enter the 
Recommendation in the field and click Add. The page refreshes to display additional 
fields. 

 

(!!) Note: Users can add an unlimited number of recommendations to each finding.  
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4. Click either the Sensitive or Significant checkboxes to designate this Recommendation as 
significant.  

 

5. Fill out the additional fields. Use the date drop-down menu to select a Recommendation 
Date, add any notes in the Comments field, and use the drop-down menus to set Monetary 
and Non-Monetary Code and Grant Type. 

6. Click Save. 

 

3.8.3 Updating Recommendations and Amounts 

Each recommendation can be updated at any time during the project. After a 

recommendation is added, additional fields appear as seen in the image below. Users can 
update recommendations, mark them as Sensitive and/or Significant, and add associated costs. 
To add costs to the recommendation and update the Total Amount: 

1. Open the desired Project folder and click the Findings tab.  
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2. Click Recommendations within the desired Finding row. The page refreshes to display the 
Finding Recommendations workspace.  

 

3. Click Amounts. The workspace refreshes and displays the Recommendation Cost 
workspace.  

 

4. Click Insert. The page refreshes to display additional fields.  

 

5. Click the CFDA Number lookup.  
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6. The Select Item pop up window appears. Select the radio button adjacent the desired 
code, and then click OK.  

 

7. The pop-up window closes, and the selected code appears in the CFDA Number field. 

8. Enter the CFDA Amount in the field. 

9. Click Save Cost Data to record the cost amount.  

10. A pop-up window appears, indicating the data was successfully saved. Click Close. 

11. The pop-up window closes. Click Back to return to the Findings Recommendations page. 

12. The Total Amount field within the Finding Recommendations workspace automatically 
updates with the sum of the cost data added. 

 

(!!) Note: The Cost Amount label and choice list values can be updated/changed at any time.  



Audit Management 

 83 

3.9 Closing the Project 

To close the project, ensure all Procedures have been reviewed (Reviewed status procedures 
feature a blue dot in the Response column), all attachments are reviewed, and all Close tab 
questions are completed. Outstanding procedures, attachments, and/or Closure questions 
prevent the project from closing.  

To close a project: 

1. Open the desired Project folder and navigate to the Closing Checklist tab. 

 

(!!) Note: All procedures must be in Reviewed (white) status to close the project.  

2. For each question in the close checklist, select the Response from the drop-down list.  

3. Enter any additional information in the Comments field and click Save.  

4. If desired, click Review to route the question group(s) for approval. 

5. Select the Recipient from the Assigned To drop-down list. 

6. Use the date picker to select Due Date. 

7. Enter any additional information in the Comments field. 

8. Click Submit for Review. The question is routed to the assigned recipient for completion. 
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9. The reviewer must sign in to eCASE Audit Management. Any assigned approvals are 
visible in their Inbox. 

10. The reviewer must navigate to the Approvals tab of the assigned project and Approve or 
Reject the closing checklist in the Closed Checklist Group Approvals section. 

 

11. After all procedures, attachments, and closure checklist items are reviewed, select Close 
from the Actions drop-down list.  

(!!) Note: Findings and the Closing Checklist may not be a requirement to close the project, 
depending upon your organizational need. If your organization requires these elements to be 
in Reviewed status, then the project cannot be closed until these elements are in the 
Reviewed status. 

 

12. The Close Folder pop-up window appears. Select the desired Closed Date using the date 
picker.  
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13. Configure the email notification, if necessary. 

14. Deliver the case folder documents, if necessary.  

15. Click Close Folder. A confirmation window appears. 

 

16. Click OK. The workspace refreshes and the project is now in Closed status.  

3.10 Cancel a Project 

Preparers can request project cancellation, if needed. Follow the steps in this section to 
cancel a project. 

1. Navigate to the project to be cancelled and click the Project tab. 

2. Click Cancel Project. 
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3. The tab refreshes to display the Cancel Project Request workspace, as shown below. Select 
the user to assign the Cancel Project Request, using the Assigned To drop-down list.  

 

4. Select a Due Date using the date picker. 

5. In the text box provided, enter a Cancellation Justification. 

6. Click Submit For Review to submit the Cancel Project Request. 

 

7. The page refreshes and the user assigned the Cancel Project Request must log in and 
access the Project and Approvals.  

8. Open the assigned Project case folder, and navigate to the Approvals tab.  
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9. Within the Project Approvals subsection, locate the Cancel Project Request and, if electing 
to cancel the project, click Approve. The project is cancelled, with the cancellation 
reflected in the status for that project. 

(!!) Note: Alternatively, the authorized user can Reject the cancellation or Send for Further 
Review, if desired. 

 



 

 88 

4 Set Up – Templates & Risk Factors 

This section explains how authorized users can create new templates, edit existing templates, 
and adjust risk factors. When a user creates a new project, all the information and data 
provided in the template is automatically populated into the respective tabs in the project. 

4.1 Create New Templates 

Templates provide a list of preconfigured procedure groups and procedures, attachments, 

closing checklists, project milestone dates, and project staff. To create a new template: 

(!!) Note: After creating a Template, the user must be listed in the Project Team tab as a 
Preparer in order to proceed with any further actions. 

1. Select New > Project Template.  

 

2. A blank project template form appears. Enter a Template Name in the field. 

3. If desired, uncheck the Active checkbox to make the template inactive.  

4. Click Save. The workspace refreshes and the Project Template page appears. 
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5. Navigate to the Project Team tab and click Add User. The Assign Role pop-up window 
appears.  

 

6. Select the Preparer role from the drop-down list. The User field appears.  

7. Click the User lookup and select the current user profile.  

8. Click Add. The pop-up window closes and the selected user appears in the Project Team 
tab as the Preparer.  

9. Navigate to the Project Template tab and click New Procedure Group. The workspace 
refreshes to display the New Procedure Group workspace. 

 

10. Enter the Group Letter in the field. 
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11. Enter the Group Name in the field.  

12. Click Save. 

 

13. The Project Template workspace refreshes, displaying the newly created procedure in the 
Groups/Procedures/Activities workspace. Within the new Procedure Group row, click New 
Procedure. 

 

14. The New Procedure workspace appears. Enter the Procedure Name in the field.  

 

15. Enter any desired elements (Purpose, Source, and Scope) for this procedure by clicking the 
corresponding button. A pop-up window appears. Enter the element information in the 
pop-up window and click Save. 
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16. After completing the desired procedure elements, click Save.  

 

17. Repeat the steps above for all procedure groups and procedures in the template. 

(!!) Note: Click Save after editing any procedure element. 

18. If applicable, navigate to the Attachments tab to add attachments to the 
procedure(s)/template.  
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19. Navigate to the Closing Checklist tab to configure the closing questions for Projects using 
this template. 

20. Click New Group. The workspace refreshes to display the Create Group workspace. 

 

21. Enter a name for the group in the field. 

22. If desired, uncheck the Is Active? Checkbox to make the group inactive. This checkbox is 
selected by default.  

23. Click Save. The workspace refreshes. Click New Question adjacent the newly created 
group.  

 

24. The tab refreshes to display the New Question workspace. Enter the question in the field. 

25. If desired, uncheck the Is Active? Checkbox to make the question inactive. This checkbox 
is selected by default.  
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26. Click Save. The workspace refreshes and the newly created question appears in the 
Closing Checklist workspace. 

27. Complete the above steps to add as many groups and questions as necessary to the 
Closing Checklist. 

(!!) Note: After creating multiple case closing questions, you can use the arrow buttons to 
order how the Groups and Questions appear in the Closing Case Checklist tab. 

 

28. Navigate to the Milestone Dates tab to add milestone dates to the template. Every project 
using this template will have these dates automatically imported.  

29. Click Add Date. The Add Date workspace appears.  

30. Enter the Date Name in the field. Fill out the Dependent Milestone, Planned Date, Days 
Before Email Notice, Recipients, and Order, if applicable. Click the checkbox to make the 
date active, if desired. 



Set Up – Templates & Risk Factors 

 94 

 

31. Click Save. The tab refreshes to display the full Milestone Dates workspace, including the 
newly added date.  

32. If desired, click Import Milestone Dates to search and import milestone dates from other 
project templates. 

33.  Select the template from the drop-down list. 

34. Enter the name of the date in the field. Click Search.  

 

35. eCASE returns results within the Milestone Date Search Results section. Click the checkbox 
adjacent the desired date name and click Add Milestone Dates.  

36. Navigate to the Project Team tab and use the Add User and/or Add Group buttons to add 
the desired Users and Groups to this template. Every project using this template will 
automatically incorporate these users into the project’s Staff tab. 

4.2 Edit Existing Templates 

eCASE Audit Management features a few preconfigured templates. Authorized users may edit 

these templates, or any other eligible template. To edit a template: 

1. Within the Launch Pad, select View > Project Templates. 
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2. The Project Templates list appears, which displays a list of all existing templates. ` 

 

3. Click the corresponding Folder ID to open the template to modify.  

4. The Project Template folder appears. Complete the desired modifications to the case 
folder.  

5. Click Save. 

(!!) Note: For existing projects using the now edited template, only the Closing Questions will 
be updated. All the edits made to the other tabs will only be reflected in new projects.  

4.3 Risk Factors 

The default Risk Factors used for each newly created Work Topic can be updated using the 
Risk Factor option within the Launch Pad. To update the default Risk Factors. 

1. Navigate to Main Menu > View > Risk Factors. 
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2. The Risk Factors Template appears. To add a new Risk Factor, click Insert. 

 

3. A new Risk Factor row appears. Enter a Risk Factor Name in the field. 

4. Adjust the Likelihood. 

5. Adjust the Impact. 

6. If necessary, click the red X to delete an entry.  

7. Click Save. 
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(!!) Note: The Risk Factors added here automatically populate the Risk Factor section of each 
Work Topic added in a Fiscal Year Plan. Any changes made are only reflected in new Work 
Topics, not work topics created prior to the modification. 

 

 

 


